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Overview of the SAS System Interface

The main SAS window contains all other SAS application windows. The main SAS
window is completely configurable, allowing you to use its features in a way that is
productive for you. Display 2.1 on page 27 shows the main SAS window as it appears
when you first start the SAS System. This section briefly describes the features of the
window.

Display 2.1 The Main SAS Window
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The following are the primary components of the main SAS window:

menu bar
presents the menus available for the active SAS application window. As you
switch between application windows, the menu bar changes. Similarly, the pop-up
menus that appear when you click on the right mouse button inside an application
window are dependent on that window.

command bar
provides a way to quickly enter any SAS command. The command bar retains a
list of the commands that you enter. To repeat a command that you entered
previously, select the command from the drop-down list and click on the check
mark button or press Enter. To switch the keyboard focus to the command bar,
press F11 (the function key defined as COMMAND BAR).
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toolbar
provides quick access to the commands you perform most often. The toolbar is
completely configurable and can contain up to 30 tools. You can associate different
sets of tools with different SAS application windows. When you create a tool, you
specify the tool button, the commands associated with the tool, help text displayed
on the status line, and the tip text. The bitmap browser provides hundreds of
images that you can use to represent your commands on the toolbar.

windowing environment
contains a workspace to open windows within the main SAS window. Certain
windows, such as windows used for navigation, can dock to the left side of the
main SAS window when Docking view is enabled from the Preferences dialog
box. Windows that cannot dock to the main SAS window open to the right of the
docking area. For more information about using dockable windows, see “Using the
Docking View” on page 29.

window bar
is located at the bottom of the main SAS window and provides easy access to any
window within the main SAS window. When a window opens, a button is placed in
the window bar representing that window. Whenever you want access to a
window, click on the button for that window. That window then becomes the active
window. You can also load a file into the application by dragging a file to a window
bar button to make the window active and then continue dragging the file into the
window. The window bar can be enabled and disabled from either the Preferences
dialog box or the window bar pop-up menu.

status line
contains a message area, the current folder for the SAS System, and the Enhanced
Editor cursor positon. The message area displays help text for menus and tools, as
well as messages that are specific to SAS application windows. The current folder
area displays the name of the current working folder. To change the current folder,
double-click on the current folder area. For more information about changing the
current folder, see “Changing the SAS Current Folder” on page 44. The Enhanced
Editor cursor position displays the current line and column when the Enhanced
Editor is the active window. The status line can be enabled and disabled from the
Preferences dialog box. The message line, the current folder, and the cursor
position can be enabled and disabled from the either the Preferences dialog box or
the status line pop-up menu.

Accessing SAS Commands, Tools, and Options from Menus
You can access SAS commands, tools, and options by selecting them from the menus

at the top of the main SAS window or by using the pop-up menus within application
windows. The menus display options available to the active window. To access a pop-up
menu for a particular window, click on the right mouse button anywhere within the
window. The pop-up menu that appears contains the menu items available for that
particular window.

Some SAS windows (such as the Explorer window) along with the main SAS window
can contain objects that have their own pop-up menus when you right-click on an
object. For example, the command bar, the toolbar and the status line each have a
pop-up menu. In these windows, the pop-up menu is specific to the selected object.
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Using the Docking View

The SAS System for Windows makes it easier for you to access files using the
docking view. When the docking view is enabled, certain windows are docked to the left
side of the main SAS window. These windows are typically used for navigation. When
you double click on an object in a docked window, a window containing the contents of
the object opens in the right side of the main SAS window.

The docking view is enabled or disabled

� from the Preferences dialog box View page

� by entering the WDOCKVIEW command in the command bar.

The WDOCKVIEW command without any arguments toggles the docking view.
Each docked window has a tab at the bottom of the docking area for easy access to

the window. When the number of docked windows is large enough so that you cannot
identify the tabs, a left and right arrow are displayed for you to navigate through the
docked windows.

Docked windows cannot be individually moved or resized. To enlarge or contract the
docking area, place the cursor over the split bar between the docking area and the
remaining portion of the main SAS window. Then click and hold down the left mouse
button. Move the mouse to the left or right to resize the docking area.

If you prefer to dock or undock individual windows, you can toggle the Docked
command using the docked window’s pop-up menu (click the right mouse button on the
window’s tab) or by selecting

Window I Docked

For more information on docking or undocking all windows, see “View Preferences”
on page 65 and “WDOCKVIEW” on page 301.

Using the Window Bar

The window bar is a reserved space at the bottom of the main SAS window used to
display a button for each opened window within the SAS System. You then have
immediate access to any opened window. When you click on a button in the window bar,
that window becomes the active window and is displayed on top of all other windows.
When you click on the button for the active window, the window is minimized.

When you open enough windows so that not all buttons fit in the window bar using
the default button size, SAS decreases the button size. If the button size is small
enough that you cannot read the button, you can place the mouse cursor over a button
and a ScreenTip tells you the window name. You enable ScreenTips using the
Preferences dialog box or by entering WSCREENTIPS in the command bar. For more
information enabling ScreenTips, see “View Preferences” on page 65 and
“WSCREENTIPS” on page 310.

An easy way to load a file into an application that accepts file input, such as the
Program Editor or the Enhanced Editor, is to drag the file to the application’s button on
the window bar which makes the application the active window. Then continue
dragging the file to the application window. Release the mouse button to load the file
into the application. You cannot drag a file onto a button. Dragging a file onto a button
causes the window for that button to become the active window.

Each button on the window bar has a menu associated with it. To access the menu,
place the cursor over the button and click the right mouse button.
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You can enable and disable the window bar either from the Preferences dialog box,
the status line and window bar pop-up menus, or by entering WWINDOWBAR in the
command bar.

Learning about the Main SAS Window

To learn about the different parts of the main SAS window, the SAS System provides
different types of screen help. The screen help is either a message that displays in the
message area of the status line or a one or two word screen tip. The message area
descriptions are available for menus, the command bar, and items in the toolbar. Screen
tips are available for the command bar, toolbar buttons, the docking area tabs, the
window bar buttons, and the status line.

If you would like a description of a menu or a menu item, select the menu or menu
item, and hold down the mouse button. As the mouse pointer passes over the menu or
menu item, a description of the item displays in the message area of the status line.
For example, when you select the File pull-down menu, the status line displays
“Perform file–related operations.” As you drag the mouse to highlight the items under
the File menu, the message area displays a short description of each item.

When you place the cursor over a toolbar button, a screen tip displays by the icon
and a longer description displays in the message area.

For other parts of the main SAS window, such as the docking area tabs, the window
bar buttons, and the status line, by placing the cursor over the item and holding it
there for a second, a one or two word screen tip pops up. When you place the cursor
over a window bar button, the screen tip contains the window name. This is very useful
when you have several windows open and the window buttons are too small to read the
window name.

If you customize the commands available from the toolbar, you can also specify the
descriptions (Tip Text and Help Text) that appear as screen tip help and a message
in the message area. To learn more about changing the toolbar, see “Customizing the
Toolbar” on page 71.

To enable or disable command bar or toolbar screen tips, you can use either the Show
ScreenTips on toolbars option in the Customize dialog box Toolbars page or enter
the TOOLTIP command in the command bar. All other screen tips can be enabled or
disabled using the ScreenTip option in the Preferences dialog box View page or by
using the WSCREENTIPS command. For more information on enabling and disabling
screen tips, see “Setting Session Preferences” on page 63,“Customizing the Toolbar” on
page 71, “WSCREENTIPS” on page 310, and “TOOLTIPS” on page 297.

Opening and Saving Files

You can open and save external files from any text editor window, such as the
Program Editor window. Some SAS windows, such as Log and Output, do not allow file
input; you cannot open files from these windows, but you can save the window contents
to external files. If you would like the default folder for the Open and Save As dialog
boxes to be the current working folder and not the SASUSER folder, you can start the
SAS System using the SASINITIALFOLDER system option. For more information, see
“SASINITIALFOLDER” on page 458.

Opening Files

To open a file from the Program Editor:
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1 With the Program Editor window active, either click on the Open toolbar button
(the opened file folder), enter DLGOPEN in the command bar, or select File and
click Open. SAS displays the Open dialog box.

2 Use the Open dialog box to select the file you want to include. By default, SAS
looks for files with the .SAS file extension (which contain SAS code, by
convention). However, you can change this by adjusting the Files of type field.
(If you change the selected file type, SAS will remember that selection and present
it as the default the next time that you open a file for that window during the SAS
session.)

3 If the file you are including contains SAS code that you want to submit, check the
Submit box before clicking OK .

Note: If you select Submit , it remains selected each time you use the Open
dialog box to open a file. You must deselect it if you do not want to submit the
contents of the file you want to open. 4

You can also drag and drop a file into the Program Editor from the Windows Explorer
or the My Favorite Folders window. To do this,

1 Open the source window.
2 Position the source window and the Program Editor window so that both are

visible.
3 In the source window, find and select the file you want to open; click and hold

down the left mouse button
4 Drag the file over the Program Editor window and release the left mouse button.

Note: The Program Editor window can hold up to 256 characters on a single line. If
you open a file with lines longer than 256 characters in the Program Editor window, the
lines are truncated unless you use the INCLUDE command with an LRECL= value
equal to the number of characters in the longest line, and you set either the
AUTOWRAP or AUTOFLOW command to ON. If you want to use the Open dialog box
to open a file with lines longer than 256 characters, use the FILENAME statement to
set up a fileref with the appropriate options and then use the fileref, enclosed in double
quotes, in the File Name field in the Open dialog box. 4

Saving Window Contents to a File
To save the contents of the active window to a file:

1 Either click on the Save toolbar button (the diskette) or select the File pull-down
menu and select Save. If you have previously saved the contents of this window to
a file (and the filename is part of the window title), SAS simply saves the contents
to the file you specified previously. If you have not saved the window contents
during this session (and the window title bar displays the name “Untitled”), then
SAS displays the Save As dialog box.

If you have previously saved the window contents but now want to save it to a
different file, select Save As instead of Save in the File pull-down menu or enter
the DLGSAVE command.

CAUTION:
Always use Save As when you want to save the contents of the editor to a new file. If
you open a text file in the editor window, whether you use the Open dialog box
or the INCLUDE command, the editor title bar displays the name of the file
that you opened. When you select the File pull-down menu and then the Save
item, SAS overwrites or appends the file of that name with the current contents
of the editor. 4
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2 Select or name the file in which to store the window contents. Optionally, you can
select a file type from the Save file as type list. SAS saves most file types as
plain text and assigns different file extensions based on the type you select; the
exception is the RTF file type, which SAS saves in rich text format (RTF).

If you select a file type from the list, SAS remembers that selection and presents
it as the default type the next time that you save a new file in that window.

Clearing the Window and Filename
To clear a SAS window of its contents and saved filename (if it has one), do one of

the following:
� press CTRL + E
� select Clear All from the Edit menu
� click on the New (the blank page) toolbar button
� select the File pull-down menu and select New
� type clear in the command bar and press Enter.

If the contents of the window have not been saved, SAS prompts you to save them
before it clears the window.

Defining Keys
To display the key definitions that are active for the SAS session (that is, the

DMKEYS entry in your SASUSER.PROFILE catalog), either type keys in the command
box or select

Tools I Options I Keys

These key definitions apply to the basic SAS windows, such as Program Editor, Output,
and Log windows. “Default Key Definitions under Windows” on page 515 contains a list
of the default key definitions. See “Keyboard Shortcuts within the Enhanced Editor” on
page 518 for default key definitions for the Enhanced Editor.

Other SAS products have their own key definitions. Use the pull-down menus in the
specific product window to access key definitions for specific products.

Although the SAS System lets you define any key listed in the KEYS window,
Windows reserves some keys for itself to maintain conformity among Windows
applications. These reserved keys are not shown in the KEYS window.

To define or redefine a key within the SAS System, place the cursor in the
Definition column across from the key or mouse button you want to define and type
the command or commands that you want to associate with that key or button. The
definition must be a valid SAS command or sequence of commands. When you specify a
sequence of commands, separate the commands with a semi-colon ( ; ). For example, if
you want to define the CTRL+H key sequence to maximize a window and recall the last
submitted program, specify the following commands in the Definitions column next to
CTL H:

zoom; recall

The SAS System does not check the syntax of a command until it is used (that is,
when the key is pressed). If you misspell a command or type an incorrect command,
you do not discover your error until you use the key and receive an error message that
indicates that the command was unrecognized.

Your key definitions are stored in your SAS user profile catalog. SAS creates a profile
catalog each time you invoke the SAS System with a different value for the SASUSER
option. Changes you make to one profile catalog are not reflected in any other.
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However, you can use the COPY command from the KEYS window or the CATALOG
procedure to copy key definition members to other profile catalogs. (For more
information, see the CATALOG procedure in SAS Procedures Guide.)

Accessing Online Help and Documentation
The SAS System under Windows provides comprehensive online HTML-based

documentation. You can access several different levels of help information, depending
on the context and the type of information you need.

Note: For full help support for the SAS System, be sure Microsoft Internet Explorer
4.0 or above is installed. SAS System Help displays best and provides full help functions
using Internet Explorer, including easy navigation, indexing, and search capabilities.
When Internet Explorer is installed, SAS System Help displays with all help functions
available. For information on defining a browser, see “Web Preferences” on page 66.

Also note that when Internet Explorer is installed during SAS installation, it is only
used for the SAS System. No changes are made to the Windows registry. 4

Getting Help from the Command Bar
You can get help for SAS language elements and SAS products by using the HELP

command in the command bar. When you enter the HELP command, the SAS System
Help displays help for either the active window or for the type of help you specify in the
HELP command argument. Table 2.1 on page 33 lists the HELP command arguments
and the resulting display in the SAS System Help.

Table 2.1 Types of Help Available Using the Command Bar

Help Argument The SAS System Help
Display

Example

none help for the active window HELP

language element help on the specified language
element

HELP FILENAME

language element type a list of links to all language
elements within the language
element type

HELP DSOPTIONS

product name product help HELP SAS/CONNECT

HELP how to use the HELP command HELP HELP

The HELP arguments for language element types include these strings:

commands lists SAS commands

dsoptions or
datasetoptions

lists SAS data set options

formats lists SAS formats

functions lists SAS functions

informats lists SAS informats
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procedures lists SAS procedures

statements lists SAS statements

systemoptions lists SAS system options

Getting Help in the Dialog Boxes
To access help in a dialog box, click on ? at the top of the dialog box, then click the

item you want information about. A pop-up window appears with a definition for the
item. To close the pop-up window, click anywhere on the dialog box. If the dialog box
doesn’t have the ? button, look for a Help button or press F1.

Getting Help for a SAS Product
To access help information about the SAS product associated with the currently

active window, click on the Help toolbar button (the book with the question mark), press
the F1 function key, or select the Help menu and Using This Window. (For example, if
you click on the Help toolbar button and the active window is a SAS/GRAPH window,
the SAS System Help displays help information about SAS/GRAPH software.)

You can also get help for a SAS product using the HELP command in the command
bar. When you use the product name as an argument to the HELP command, the SAS
System Help displays the product help. For example, if you entered HELP SAS/GRAPH
in the command bar, the SAS System Help will open to the SAS/GRAPH help.

Getting Help from the Help Menu
The Help menu is always available within your SAS session. Here are descriptions

of the help topics available from the Help pull-down menu:

SAS System Help
comprehensive SAS language and option information, including information that
is specific to the Windows environment.

Using this Window
help information relevant to the currently active window. This is the same as
clicking on the Help toolbar button or pressing the F1 key.

Books and Training
provides access to SAS System HTML-based books and tutorials available on
CD-ROM. The SAS Online Tutor is a separately licensed SAS product.

Getting Started with SAS Software
opens the SAS System Help to a tutorial that will help you get started with SAS.

SAS on the Web
provides links to useful areas on the SAS Institute web site, including technical
support, frequently asked questions, sending feedback to SAS, sample code, and
the SAS homepage.

Getting to SAS Institute (and Other Web Sites) from within the SAS System
The SAS System is configured to launch your local web browser to view HTML files.

You can invoke your web browser in a few ways:
� Enter a URL (uniform resource locator) in the command bar. The SAS System will

launch the browser that you specified in the Preferences dialog box Web page.
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� Enter the WBROWSE command, which will launch the browser with SAS
Institute’s home page or another default URL that you can specify in the
Preferences dialog box Web page. For more information about the WBROWSE
command, see “WBROWSE” on page 299.

Note that you can access web pages on the Internet (such as the SAS Institute home
page) only if your workstation is connected to a network that allows such access.

Working within Your SAS Session
The following sections describe how to work within your SAS session. These features

include the SAS Text Editor (Program Editor and SAS NOTEPAD), the clipboard,
special characters, SAS commands, and the SAS working folder. For information about
using the Enhanced Editor, see “Using the Enhanced Editor” on page 45.

Using the SAS Text Editor Windows
The SAS text editor windows (including Program Editor and NOTEPAD) work

similar to other Windows editors. Thus, you can edit your SAS code without learning
how to use a new text editor.

Using Line Numbers
If you are familiar with the SAS Program Editor window under other operating

systems, such as OS/390, notice that line numbers are turned off by default under
Windows. You can enter the NUMBERS ON command from the command box to
display line numbers in the Program Editor window.

You can also control line numbers using the Editor Options dialog box when the
Program Editor or NOTEPAD is the active window. To open the Editor Options dialog
box:

1 Enter EDOP in the command bar or select

Tools I Options I Editor

2 Click on the down-arrow in the drop-down list and select Text Editing Options.
3 With the right mouse button select Nums.
4 With the left mouse button, select Modify.
5 In the Value combo box, select either Yes or No and click OK .

Moving the Cursor
The cursor movement keys (arrow keys, PgUp, PgDn, and so on) function the same

way in SAS text windows as they do in other Windows applications.
Pressing the CTRL key with the left arrow (word left) or right arrow (word right)

causes the cursor to move one word at a time. When advancing through text, the
word-left and word-right commands stop at the end of the text on a line and at the
beginning of the first word on a new line. You can move to the top of a file by pressing
CTRL+PgUp or to the bottom of a file by pressing CTRL+PgDn.

Pressing the Home key causes the cursor to go to the beginning of the current line
unless the command line (not the command bar) is active in the active window. Pressing
the Home key when the command line is active causes the cursor to toggle between the
current cursor position in the text and the command line. The F11 key moves the cursor
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to the command bar. You can toggle the command line on and off using the COMMAND
command or by selecting Command line in the Preferences dialog box General page.

Using Tabs
Many text editors retain tab characters, while others expand tabs into space

characters. The SAS Program Editor window expands tabs into space characters.
Pressing the Tab key inserts spaces and moves any text to the right of the cursor.

Understanding Line Breaks
Conceptually, line breaks are at the end of the line rather than at the beginning.

Pressing the Enter key creates a line break. To delete a line break, press the Backspace
key at the beginning of a line or press the Delete key at the end of the line.

Selecting Text
You can use the mouse or the SHIFT key in combination with the cursor movement

keys to select text. The marking of an area of text continues until you release the
mouse button or release the SHIFT key. To select all of the text in the active window,
select the Edit menu and then select Select All. The following are some advanced
text selection methods:

� Double-click on a single word to select it. To select an entire line, hold down the
CTRL key as you click on the line you want.

� Use the ALT key as you hold down the mouse button and drag the mouse to select
a rectangular block (or column) of text (as illustrated below.)

� Use the SHIFT key in combination with the mouse button to select the text
between the current text cursor and the position in the text where you click. You
can also use this technique to extend a text selection. (You can use this feature
only within the current page.)

If characters are selected and you start typing text, the marked area is replaced with
the new text. This occurs even if you have moved the cursor away from the marked
area. For information about marking and copying text with a mouse, see “Using the
Clipboard” on page 39.
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To unmark text, click the left mouse button in the window. Alternatively, you can
unmark text by selecting Deselect from the Edit menu or you can press the ESC key.
You can also unmark text using the up, down, left, and right arrow navigation keys if
Enable unmarking with navigation keys is selected in the Preferences dialog box
Edit page. Entering the WNAVKEYUNMARK ON in the command bar also enables
unmarking with the arrow navigational keys.

Deleting Text
The Delete key deletes the currently selected text, if there is any; otherwise, it

deletes the character to the right of the cursor. To delete from the cursor to the end of
the current line, press ALT+Delete. To delete from the cursor to the end of the current
word, press CTRL+Delete. To delete from the cursor to the start of the current word,
press CTRL+Backspace.

You can also use the Edit menu to delete text. To delete all text in the window, click
Clear All. To delete only selected text, click Clear. To delete selected text and copy
that text to the Windows clipboard, click Cut.

Dragging and Dropping Text
Table 2.2 on page 37 lists the places from which you can drag text and to which you

can drop the selected text.

Table 2.2 Summary of Text Drag and Drop Possibilities

Drag text from and drop it to

any SAS text window another SAS window that supports text editing
(such as the Program Editor window)

any SAS text window another Windows application that supports text
drag and drop

a Windows application that supports text drag
and drop

any SAS window that supports editing

Windows Explorer (text file item) any SAS window that supports editing

To drag and drop text from one window to another:

1 Arrange your windows, if necessary, so that both the source and target windows
are visible on the display.

Note: Instead of arranging your windows so that the target window is visible, the
target window will become the active window when you drag the selected text to
the target window’s button on the window bar. 4

2 Select the desired text from the source window.

3 Click and hold the left mouse button with the pointer on the selected text.
4 With the mouse button still pressed, drag the text to the target window.

5 Move the mouse pointer to the position where you want to insert the text. (If you
plan to just submit the text as SAS code for processing, position the mouse pointer
anywhere in the window).

6 Release the mouse button. The text is either included at the point where you
positioned the cursor, or it is submitted to the SAS System for processing. (The
default action depends on the type of the target window.)
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You can override the default action of the drag and drop by initiating the drag and
drop using the right mouse button. This is called nondefault drag and drop. When you
drag the selection to the target SAS window and release the mouse button, SAS
displays a popup menu to let you choose which action to perform.

Table 2.3 on page 38 is a summary of drag-and-drop actions available for the possible
target windows in SAS.

Table 2.3 Summary of Drag-and-Drop Actions

Data Target

Default

Action

Nondefault

Actions

text SAS text editor move move, copy, cancel

text PROGRAM

EDITOR

copy copy, submit, cancel

file SAS text editor not valid not valid

file PROGRAM

EDITOR

move copy, submit, cancel

file LOG, OUTPUT submit submit, cancel

The actions that occur when you drag text out of a SAS window into another
Windows application depend on the target application. In most cases, dragging and
dropping text between SAS and other applications actually moves the text from one
window to another (that is, the text is cut from one window and placed in the other).

You can change that behavior by applying a drag-modifier—a key you press while
you drag and drop. To copy text from one window to another (instead of moving it),
press and hold the CTRL key before and during the drag and drop. When you release
the mouse button to drop the text, release the CTRL key as well.

Drag Scrolling
While dragging text to a SAS text editor window, you can cause the target window to

scroll vertically or horizontally. This lets you drop text in a window area that is not
currently visible.

Once you have selected the text and drag it to the SAS text editor window, pause
near the border of the SAS text editor window. The window scrolls in the direction of
that border. For example, to cause the target window to scroll down, drag the mouse
pointer just above the bottom border of the window and pause.

Drag scrolling only happens when you pause near the drop area border; it does not
occur if you drag quickly past the border.

Using Rich Text Format Text
When you copy text out of a SAS window to the clipboard and paste it into the

window of another application, the text retains all of the format information it had in
SAS (except for color) if the target window accepts RTF formatting. For example, the
Windows Notepad application does not preserve formatting, but Microsoft Wordpad and
many word processors do. The same is true when you drag text out of SAS and drop it
in another application window.

If the display font is Sasfont, any text that you copy out of SAS is formatted with the
SAS Monospace TrueType font. If your text has other highlighting attributes, such as
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underline, those attributes are also transferred to the target window in the other
application (provided the target window supports rich text format (RTF)).

Saving Program Editor Files Using Autosave
To be sure that you do not lose any of your work in the Program Editor, the SAS

System can automatically save your files at an interval you specify. The interval can
range from 0 (Autosave off) to 480 minutes. The default interval is 10 minutes. To
enable or disable autosave and set the interval, select

Tools I Options I Preferences... I Edit page

You can also use the WAUTOSAVE command to enable, disable, and set the interval.
WAUTOSAVE INTERVAL=minutes will turn on autosave using minutes as the interval.

For more information on the Autosave feature, see “Edit Preferences” on page 65 and
“WAUTOSAVE” on page 298.

Understanding Unique Features of the Editor
The following features of the SAS Text Editor window are different from the

standard features of other editors commonly used in the Windows environment:
� The SAS Text Editor window allows you to move the cursor past the last character

entered on a line or past the last line of text entered.
� You can mark an area of text, move the cursor away from the marked area, and

the marked text remains marked.
� You can unmark text by pressing the ESC key.
� You can use Shift+Tab to delete blank space characters back to the last tab stop.

Navigating with Microsoft IntelliMouse
The SAS System provides support for the Microsoft IntelliMouse. The IntelliMouse is

a modified mouse that includes a rotation wheel (wheel control) that enables new forms
of navigation. The IntelliMouse works within SAS System windows that use a vertical
scrollbar for scrolling the window contents.

With the IntelliMouse, you can use the mouse to scroll instead of interacting with the
navigational controls in the SAS System windows. To scroll with the IntelliMouse, you
rotate the wheel control forward or backward, which is equivalent to pressing the up
arrow or down arrow on the scrollbar.

The IntelliMouse also supports AutoScroll. To initiate AutoScroll, click the mouse
wheel and then move the mouse away from the origination point. The contents of the
window will start to scroll in the direction you move the mouse. The farther away you
move the mouse from the origination point, the faster the contents will scroll. Pressing
a key, clicking a mouse button, or rotating the mouse wheel will terminate AutoScroll
mode.

You can modify IntelliMouse settings through the Windows Control Panel mouse
settings. For more information about IntelliMouse, see the Microsoft documentation.

Using the Clipboard
The Windows clipboard enables you to exchange text and graphics between

applications. You can also submit SAS code stored on the clipboard. The clipboard uses
operating system memory as an intermediate storage buffer for exchanging text and
graphics. With the clipboard, you can move text between
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� windows within the SAS System
� the SAS System and other Windows applications
� two SAS sessions
� two SAS processes.

The SAS System under Windows communicates with the clipboard using these
formats:

SAS text format
preserves the text and color attributes between SAS sessions. This format is
understood by the SAS System, but not by other Windows applications.

Windows text format
is understood by most Windows applications and is called the ANSI text format.

RTF text format
encapsulates text font and highlighting attributes when copying text between
applications that both support RTF format. SAS can only cut and copy text in RTF
format; you cannot paste RTF text into a SAS window.

Unicode text format (Windows only)
is a universal text format that can represent all possible characters. The format is
also referred to as a wide-character format. For more information on this text
format, see your Windows NT documentation.

Windows bitmap format
is for graphics, and windows in SAS/ASSIST software. This format is understood
by most Windows applications and is called the BITMAP format.

Windows metafile (WMF) format
is used in many SAS applications that support the GSTORE command, such as
the Graphics Editor in SAS/GRAPH software, SAS/QC software’s ISHIKAWA
procedure, and SAS/INSIGHT software. The metafile format provides more
information about the image than the bitmap format and is sometimes called the
PICTURE format.

DIB (Device Independent Bitmap) format
is used with color bitmap files. When a bitmap is stored in the DIB format, colors
map correctly from one device to another.

These formats enable you to copy text and SAS bitmapped information (for example,
from a graphic) to another application. You can also use the Print Screen and
ALT+Print Screen keys to copy information from your SAS session to the clipboard.
Pressing Print Screen places the entire display in bitmap form on the clipboard.
Pressing ALT+Print Screen places just the SAS session (including any menus and scroll
bars) or the active dialog box (if any) on the clipboard.

You can use the clipboard only if both the source and destination applications provide
support for the clipboard facility and for the format you are using. Note that whereas
some operating environments allow multiple paste buffers, the SAS System under
Windows uses the Windows clipboard, which is a single buffer.

Selecting and Copying Text
For windows that contain text, such as the Program Editor, Notepad, Log, Output,

and KEYS windows, you can hold down either the left mouse button or ALT + the left
mouse button and drag the mouse to mark the area you want to cut or copy. Holding
down the left mouse button when you are selecting multiple lines selects whole lines of
text. Holding down ALT + the left mouse button selects a rectangular block or column
of text. The text area is immediately marked in reverse video while you are dragging
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the mouse. In text windows, you can scroll while you are dragging the mouse by moving
the cursor beyond the border of the window in the direction you want to scroll. To
extend the selection of a text area, use the SHIFT key + the left mouse button. Release
the mouse button when you have included all the text you want to copy.

To copy marked text to the clipboard, do one of the following:
� click on the Copy toolbar button (the double document)

� select the Edit pull-down menu and then select Copy
� press CTRL+C

To paste text that is stored on the clipboard, position the cursor in a text area in a
window and do one of the following:

� click on the Paste toolbar button (the clipboard and document)

� select the Edit pull-down menu and then select Paste
� press CTRL+V

The text from the clipboard is pasted to the area you indicate. If there is already an
area of selected text within the target window, the selected text is replaced with
contents of the clipboard. You can paste text only into SAS windows that accept text
input, such as Program Editor or the SAS Notepad.

Selecting and Copying in Non-Text Windows
For windows such as the GRAPH and SAS/ASSIST windows, an area is marked by a

box, not by reverse video. The box indicates that the area you are marking is in bitmap
format. After you finish marking an area, you can copy it to the clipboard. If the
window you are working in has no Edit pop-up menu, you can use the following keys
combinations to perform the copy and paste functions:

CTRL+C copies the selection to the clipboard.

CTRL+V pastes the contents of the clipboard.

Using the GSTORE Command
SAS/QC software’s ISHIKAWA procedure and the Graphics Editor support the

storing of metafile graphics format as well as bitmap formats to the clipboard. In the
Graphics Editor, the area you mark is enclosed in a box, and you cannot scroll as you
mark. The GSTORE command should be used to store the currently marked area (the
entire screen when used with the ISHIKAWA procedure) to the Windows clipboard in
device-dependent bitmap (BMP), device-independent bitmap (DIB), and metafile
(PICTURE) graphical data formats. You can also select the Edit pull-down menu and
then select Copy to store the marked area to the clipboard.

Pasting Bitmapped Information into Your SAS Session
Some windows, such as the BUILD: DISPLAY window for FRAME entries in

SAS/AF software, let you paste bitmaps into the window. For more information, see
“Pasting an OLE Object from the Clipboard” on page 189.

Also, you can paste bitmaps into the SAS/GRAPH window to import graphics. For
more information, see “Importing Graphics from Other Applications” on page 143.

Submitting SAS Code from the Clipboard
The SAS System under Windows enables you to use the Windows clipboard to

submit SAS code. This feature can be used to copy or cut SAS code from another
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application, such as the Windows Notepad or another text editor, and submit it to the
SAS System for execution. This is also convenient for submitting the sample programs
that are available in SAS System Help.

To submit SAS code stored on the clipboard, select the Run pull-down menu and then
select Submit clipboard with the Program Editor window active. Alternatively, you
can use the GSUBMIT command from the command line, with the following syntax:

gsubmit buf=default

The GSUBMIT command can be used to submit SAS code stored on the clipboard
even if the Program Editor window is not the active window (or is closed). If you use
the GSUBMIT command often, you may want to define an icon for it in the tool bar, or
assign the GSUBMIT command to a function key. For more information about how to
define toolbar buttons, see “Customizing the Toolbar” on page 71.

Creating Text Highlighting and Special Characters
This section describes special character attributes and alternate ASCII characters.

Special Character Attributes
The SAS NOTEPAD and SAS/AF applications let you use extended color and

highlight attributes for text. To access these attributes, press the ESC key and the
appropriate letter or number to turn a color or attribute on or off. With this feature,
you can alter the color or attributes of entire lines or individual words or letters. Valid
colors and attributes, as well as the keys you use to implement them, are listed in Table
2.4 on page 42 and Table 2.5 on page 43. You can type the letters for the colors in either
uppercase or lowercase.

Table 2.4 Extended Color Key Sequences

Key Color Key Color

ESC+A gray ESC+B blue

ESC+C cyan ESC+G green

ESC+K black ESC+M magenta

ESC+N brown ESC+O orange

ESC+P pink ESC+R red

ESC+W white ESC+Y yellow
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Table 2.5 Extended Attribute Key Sequences

Key Description

ESC+0 turns off all highlighting attributes.

ESC+2 turns on the underline attribute.

ESC+3 turns on the reverse-video attribute.

Alternate ASCII Characters
If you want to create alternate ASCII characters such as foreign language characters,

you can use the ALT key in combination with the ASCII character code. Use the
numeric keypad with Num Lock on to enter the character code. For a list of ASCII
character codes and instructions about how to use the ALT key sequences, see your
Windows documentation.

Issuing SAS Commands
The following sections describe various ways you can issue commands to the SAS

System under Windows.

Using Menus to Issue Commands
Many commands are already assigned to menu items for the windows in which they

apply. For example, selecting the Run pull-down menu and then selecting Submit in the
Program Editor window is the same as entering SUBMIT on the Program Editor
window command line.

The items in the menu bar and pop-up menu vary depending on the active window.
This ensures that each menu item is valid and appropriate for the currently active
window.

Using the Command Line to Issue Commands
If you want to use the command line to issue commands, select Command Line from

the Preferences dialog box View page. (For more information, see “Setting Session
Preferences” on page 63.) This places a command line in each SAS window. You can
then enter commands at the command line in the window to which the commands
apply. For example, the INCLUDE command applies in the Program Editor window,
but not in the Log window.

Using the Command Bar or Command Box to Issue Commands
The command bar and the command box offer a central location from which you can

enter any SAS command, as long as the command is valid for the active window. If you
enter a command that is not valid for the active window, SAS issues an error message.

By default, SAS displays a command bar at the top of the main SAS window. You can
also undock the command bar and use it in a separate window. To undock the command
bar:

1 Position the cursor over the command bar (not in the text field)
2 Click the right mouse button and select Docked

To dock the command bar again:
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1 Position the cursor over the command box (not in the text field)

2 Click the right mouse button, and select Docked, or double-click the left mouse
button in the command box title bar.

To move your cursor to the command bar, press F11. Pressing F11 when you are using
the command box docks the command box and places the cursor in the command bar.

The SAS System stores the commands that you enter in the command bar from
session to session, and you can easily retrieve previously entered commands by
selecting them from the drop-down list. The default number of commands to save is 15,
but you can save from zero to 50 commands. SAS can store the commands either in
order of the most recently entered or in order of the most frequently used. To store the
commands by the most recently used, select Sort commands by most recently used
in the Customize Tools Toolbar page. When this option is not selected, the commands
are sorted by the most frequently used.

You can also retrieve previously entered commands by starting to type them in the
command bar. If Use AutoComplete is selected in the Customized Tools Toolbar page,
the SAS System completes the command that best matches the command you are
entering.

You can select your preferences for the command bar by using the Customize Tool
dialog box (described in “Setting General Toolbar Preferences” on page 71). To open the
Customize Tool dialog box, enter the TOOLEDIT command (described in “TOOLEDIT”
on page 294) or select

Tools I Customize...

Using the Toolbar to Issue Commands
The toolbar provides a convenient way to issue commands that you use often. To

submit a command using the toolbar, simply click on the tool button that represents the
command you need. To learn which tools perform what commands, position the mouse
pointer over a tool briefly to reveal the screen tip for that tool.

When you start the SAS System, the toolbar displays at the top of the main SAS
windows. You can undock the toolbar and use it in a separate window by

1 positioning the cursor over the toolbar (not over a tool)

2 click the right mouse button and select Docked

To dock the toolbar again

1 positioning the cursor over the toolbar (not over a tool)

2 click the right mouse button and select Docked or double-click the left mouse
button in the toolbar title bar

You can add or change the tools defined in the tool bar and customize the toolbar for
an application. For more information, see “Customizing the Toolbar” on page 71.

Changing the SAS Current Folder
The current folder is the operating system folder to which many SAS commands and

actions apply. The SAS current folder is displayed in the status line at the bottom of
the main SAS window. By default, the SAS System uses the folder designated by the
SASUSER system option in the SAS configuration file as the current folder when you
begin your SAS session. You can specify a different default current folder by changing
the Start In field on the Properties page for the SAS program shortcut or by
specifying the SASINITIALFOLDER system option during SAS invocation. For more
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information on using the SASINITIALFOLDER system option, see
“SASINITIALFOLDER” on page 458.

Interactively Selecting a New Current Folder

To change the SAS current folder during your SAS session, double-click on the
current folder in the status line. Then use the Change Folder dialog box (shown in
Display 2.2 on page 45) to select a new current folder.

Display 2.2 The Change Folder Dialog Box

If you organize your files so that each project has its own folder, then this Change
Folder dialog box lets you quickly switch between projects. As you select different
projects, the dialog box retains the directories you select in the Folder drop-down list.

Using SAS Statements to Change the Working Folder

You can change the working drive and folder by submitting the change directory (CD
or CHDIR) command with the X statement in SAS. The SAS System intercepts the
change directory command and then changes drive commands and changes its working
folder.

For example, the following statements change the working folder for your SAS
session to the MYDATA folder and G:\SALES\JUNE folder, respectively:

x ’cd \mydata’;
x ’cd g:\sales\june’;

To simply change the working drive, you can submit a change drive command (the
drive letter followed by a colon) such as the following:

x ’a:’;

Using the Enhanced Editor

The Enhanced Editor is an ASCII editor that uses visual aides to help you write and
debug your SAS programs.
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Enhanced Editor Features
The Enhanced Editor includes many of the features from the Program Editor in

addition to the following:
� SAS program elements are color-coded, including procedures, keywords, informats

and formats, dates, numeric and string constants, macro keywords, undefined
keywords, and more.

� SCL programs, HTML documents and text documents can be color-coded.
� You can create your own color schemes or use schemes provided with the

Enhanced Editor.
� The Enhanced Editor can automatically indent the next line when you press the

Enter key.
� You can view the high level flow of your SAS program or see each detailed

statement by expanding or contracting sections of SAS procedures, data steps, and
macros.

� Using the keyboard macro recorder, you can create macros that record and play
back program editing commands.

� Abbreviations let you create shortcuts for entering text.
� Bookmarking lines allows easy access to different sections of your program or

document.
� You can customize keyboard shortcuts for most Enhanced Editor commands.
� Multiple instances of the Enhanced Editor can be open at one time.

Opening Files
To open a new file, select

View I Enhanced Editor

Alternatively, you can open new files using the New toolbar button, the File menu,
or the WEDIT command. For more infomation about the WEDIT command, see
“WEDIT” on page 301.

To open an existing file, make an existing Enhanced Editor window the active
window and do the following:

� Click on the Open toolbar button.
� In the Open dialog box, select a folder and file.
� Click on Open .

To append a file to the bottom of an opened file:
� Click in the Enhanced Editor window in which the file will be appended.
� Select

File I Append...

� Select a folder and the file to append.
� Click on Open .

Saving Files
An asterisk ( * ) that appears in an Enhanced Editor window title bar indicates that

the editor contains text that has not been saved to disk. Enhanced Editor windows that
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display ’Untitledx’ in the title bar are new files that have never been saved. The x
indicates a window number.

To save the contents of the Enhanced Editor window, click on the Save toolbar button
(the diskette). If the file is to be saved for the first time, the Save As dialog box will
open for you to name the file and folder.

To save a file with a new name, select

File I Save As

Then, enter the filename and folder in the Save As dialog box.

Checking for Coding Errors
By color coding program components, the Enhanced Editor can help you check for

errors such as misspelled keywords and unmatched quotes and comments. For
information on defining colors for program components, see “Setting Appearance
Options” on page 59.

For example, if you define the undefinded keyword foreground color to black, the
undefined keyword background color to gray, and the keyword color to blue, the
Enhanced Editor would change a keyword to blue when it is entered correctly. As the
first word in a statement is a SAS keyword, you could recognize misspelled keywords
instantly by the black text on a gray background at the beginning of a line.

Unmatched quotation marks are easily spotted as the text remains the same color
until the string is closed with a matching quotation mark.

As with strings, all text that follows the open comment symbol /* remains the same
color until the Enhanced Editor recognizes an ending comment symbol */.

To check for unmatched parenthesis or brackets, place the cursor before a
parenthesis or bracket and press Ctrl + ]. If one is not found, the cursor does not move.

Using the Enhanced Editor Window
This section explains the many functions available to you in the Enhanced Editor

window.

Overview of the Enhanced Editor Window
When the Enhanced Editor opens a new file, the title bar of the Enhanced Editor

window contains the Enhanced Editor icon (as shown in Display 2.3 on page 47) and
the text ’Untitledx’, where x is a window number.

Display 2.3 Enhanced Editor Icon

Once you start entering text, the title bar displays an asterisk ( * ) which indicates
that changes have been made to the file and the changes have not been saved to disk.
Once you save the file, the file name displays in the title bar and the asterisk
disappears until you start entering additional text.

The margin on the left side of the Enhanced Editor window is used to select lines of
text, expand and collapse code sections, and display line numbers, code section
brackets, and bookmarks.
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Moving the Cursor

The Enhanced Editor has numerous key sequences for moving the cursor, as shown
in Table 2.6 on page 48.

To go to a specific line, use the Go To Line dialog box:

1 Enter the key sequence Ctrl + G.

2 Enter the line number.

3 Click on OK .

By default, when you click the mouse button past the end of a line, the cursor is
placed after the last character in a line.

To enable the Enhanced Editor for placing the cursor past the end of a line:

1 Select

Tools I Options I Enhanced Editor... I General

2 Select the Allow cursor movement past end of line check box.

3 Click on OK .

Table 2.6 Key Sequences for Moving the Cursor

Use Key Sequence... To Move the Cursor....

Up arrow up one line

Down arrow down one line

Left arrow left one character

Right arrow right one character

Page Down down a page

Page Up up a page

Home to the beginning of the current line

Ctrl + Home to the beginning of the document

End to the end of the current line

Ctrl + End to the end of the document

Ctrl + up arrow towards the top of the file while scrolling up

Ctrl + down arrow towards the bottom of the file while scrolling down

Ctrl + right arrow to the start of the next word

Ctrl + left arrow to the start of the previous word

Ctrl + ] to the matching parenthesis or bracket

Ctrl + G to a specific line number

Alt + up arrow to the first visible line

Alt + down arrow to the last visible line

Alt + up arrow to the first visible line

Alt + right arrow to the next case change or word boundary
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Use Key Sequence... To Move the Cursor....

Alt + left arrow to the previous case change or word boundary

Shift + Tab backwards to the previous tab stop

Selecting and Editing Text
To select one or more lines of text using the margin:
1 Click and hold down the left mouse button in the margin on the first line of text

you want to select.
2 Still holding down the left mouse button, drag the cursor within the margin to the

last line you want to select.
3 Release the left mouse button.

Selected text is marked in reverse video.
You can also select single or multiple characters, or whole lines of text when you:
1 Click and hold down the left mouse button before the first character you want to

select.
2 Still holding down the left mouse button, drag the cursor to the last character you

want to select.
3 Release the left mouse button.

Keyboard shortcuts are also available to select text. To extend a selection in a
particular direction, press the Shift key and then a directional arrow. Pressing Shift +
left arrow or right arrow will select one character at a time. Pressing Shift + up arrow
or down arrow will select one line at a time. For a complete list of selection keyboard
shortcuts, see the Selection category in “Keyboard Shortcuts within the Enhanced
Editor” on page 518.

To unmark selected text, press any directional key.
To copy selected text, press Ctrl + C or select

Edit I Copy

To cut selected text, press Ctrl + X or select

Edit I Cut

To paste from the clipboard, press Ctrl + V or select

Edit I Paste

To move selected text:
1 Place the mouse cursor over the selected text.
2 Click and hold down the left mouse button. The cursor displays a vertical line.
3 Still holding down the left mouse mouse button, drag the selected text and place

the vertical line to the position where you want to place the text.
4 Release the left mouse button.

Copying or cutting text places the text in the Windows clipboard. If you select text
and then delete the text using the Delete key, the deleted text is not placed in the
clipboard.

Text from the clipboard is pasted to the area you indicate. If there is already an area
of selected text within the target window, the selected text is replaced with contents of
the clipboard.

Note: In addition to using commands from the Edit menu, editing commands are
available from the pop-up menu when you click the right mouse button in the Enhanced
Editor window. 4
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Dragging and Dropping Text
To move or copy text using drag and drop:

1 Select the text to move or copy and hold down the left mouse button.
2 To move the text, drag the text to the desired location and release the left mouse

button. To copy the text, press the Ctrl key, drag the text to the desired location,
and release the left mouse button.

To disable drag and drop editing::
1 Select

Tools I Options I Enhanced Editor... I General

2 Uncheck the Drag and drop text editing check box and click on OK .

Finding and Replacing Text
To find text:

1 Open the Find dialog box by selecting

Edit I Find...

2 Complete the following:

Find text:
Enter a text string to find.

Find in:
Click in this list box and specify whether to search in the code only, in the
comments only, or in both the code and comments.

Direction
Up specifies to search from the cursor position towards the beginning of the
file. Down specifies to search from the cursor position towards the bottom of
the file.

Match whole word only
Select to specify that a match of the text must be a whole word and not part
of a word.

Match case
Select to specify that upper and lower case characters must match exactly.

Regular expression search
Select to specify that the text string includes a regular expression. A regular
expression is used to search for a string or substring using special characters
as wildcards. For a description of special characters used in regular
expressions, click on Help in the Find dialog box.

3 Click on Find Next .

To find and replace text
1 To search only within a subset of text, select the text.

2 Open the Replace dialog box by selecting

Edit I Replace...

3 Complete the following:

Find text:
Enter a text string to find and replace.
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Replace with:
Enter the replacement string.

Find in:
Click in this list box and specify whether to search in the code only, in the
comments only, or in both the code and comments.

Direction
Up specifies to search from the cursor position towards the beginning of the
file. Down specifies to search from the cursor position towards the bottom of
the file.

Match whole word only
Select to specify that any match of the text must be a whole word and not
part of a word.

Match case
Select to specify that upper and lower case characters must match exactly.

Regular expressions
Select to specify that the text string includes a regular expression. A regular
expression is used to search for a string or substring using special characters
as wildcards. For a description of special characters used in regular
expressions, open the Find dialog box from the Edit menu and click on Help .

4 Click on Find Next .

5 If the text is found, click on one of the following:

� Replace to replace this single occurrence of the text with the replacement
string.

� Replace All to replace all occurrences of the text in the file with the
replacement string.

� Replace in Selection to search within the text that you have selected and
replace all occurrences of the find string with the replacement string.

Using Automatic Indenting and Tabs
When you press the Enter key, you automatically indent the next line by the amount

of space the current line is indented. If you prefer not to use automatic indentation:

1 Select

Tools I Options I Enhanced Editor I General

2 In the Indentation box, select the None radio button.

In addition to automatic indenting, you can indent using the tab key. Pressing the
Tab key moves the cursor and any text to the right of the cursor by the amount of space
specified in the Tab size: field of the Enhanced Editor Options dialog box. If you want
to insert spaces instead of tab characters when you press the Tab key, select the Insert
spaces for tabs check box.

Note: Changing the tab size will modify tab settings to the new value in all
Enhanced Editor windows. 4

Bookmarking Lines
When you bookmark a line, you create a line marker that is used to easily access

that line. A vertical rectangle in the margin indicates that the line is bookmarked.
Table 2.7 on page 52 shows the keyboard shortcuts you can use with bookmarking.
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Table 2.7 Keyboard Shortcuts for Bookmarking Lines

To... Press...

Bookmark a line Crtl + F2 on an unmarked line

Unmark a line Ctrl + F2 on a marked line

Go to the next bookmark F2

Go to the previous bookmark Shift + F2

Using Abbreviations
You can define a character string which when entered and followed by the Tab key or

the Enter key will expand to a longer character string. For example, you could define
the abbreviation myv6sasfiles, which would expand to
’c:\winnt\profiles\myid\personal\mysasfiles\v6’;. Abbreviations are actually macros
whose task is to insert one or more lines of text.

To create an abbreviation
1 Select

Tools I Add Abbreviation...

2 In the Abbreviation field, enter the name of the abbreviation.
3 In the Text to insert for abbreviation field, enter the text the abbreviation

will expand into.
4 Click on OK .

To use an abbreviation, type the abbreviation. When an abbreviation is recognized, a
tooltip displays the expanded text. Press the Tab key or Enter key to accept the
abbreviation.

To modify an abbreviation:
1 Press Ctrl + Shift + M or select

Tools I Keyboard Macros I Macros...

2 Select the abbreviation from the list of Current Macros.
3 Click on Edit.
4 Select the string in the Macro Contents field.
5 Click on Modify .
6 Make your modification in the Insert String dialog box and click on OK .
7 Click on OK in the Edit Keyboard Macros dialog box.
8 Click on Close in the Macro dialog box.

To delete an abbreviation:
1 Press Ctrl + Shift + M or select

Tools I Keyboard Macros I Macros...

2 Select the abbreviation from the list of Current Macros.
3 Click on Delete.
4 Click on Close .

Submitting Your Program
To submit your program, do one of the following:
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� Click on the Submit toolbar button.
� Press F3 or F8.

� Select

Run I Submit

The Enhanced Editor Options dialog box provides the Clear text on submit
setting for you to specify whether or not you would like the contents of the Enhanced
Editor window cleared after submitting your program. If you would like your program
to remain in the editor window, be sure not to select this option. For more information,
see “Setting Enhanced Editor Options” on page 57.

Using Keyboard Mappings
The Enhanced Editor provides extensive keyboard mappings for the Enhanced

Editor. “Keyboard Shortcuts within the Enhanced Editor” on page 518 provides a
complete list of commands and their default keyboard shortcuts.

Some of the more useful default keyboard mappings include:

Table 2.8 Useful Keyboard Shortcuts

Add a new abbreviation CTRL + Shift + A

Toggle expand current line Alt + Num *

Collapse all code sections Alt + Ctrl + Number pad-

Expand all code sections Alt + Ctrl + Number pad +

Toggle marker on the current line Ctrl + F2

Go to the next marked line F2

Go to the previous marked line Shift + F2

Go to line Ctrl + G

Convert selected text to uppercase Ctrl + Shift + U

Convert selected text to lowercase Ctrl + Shift +L

For information on defining keyboard shortcuts, see “Customizing the Enhanced
Editor Keyboard” on page 61. For a complete list of keyboard shortcuts, see “Keyboard
Shortcuts within the Enhanced Editor” on page 518.

Using Keyboard Macros
A keyboard macro is a series of Enhanced Editor commands and instructions that

you group together as a single command to accomplish a task automatically. Instead of
manually performing a series of time-consuming, repetitive actions, you can create and
run a single macro. You run a macro from the Tools menu or by using a keyboard
shortcut. For information on defining a keyboard shortcut for using macros, see
“Customizing the Enhanced Editor Keyboard” on page 61.

You can create a macro by recording it from the Enhanced Editor window:
1 Start recording either by pressing Alt + Shift + R or by selecting

Tools I Keyboard Macros I Record New Macro

2 Execute the sequence of actions to accomplish the task.
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3 Stop recording either by pressing Alt + Shift + R or by selecting

Tools I Keyboard Macros I Stop Recording

4 If desired, define a keyboard shortcut to play the macro. For information, see
“Customizing the Enhanced Editor Keyboard” on page 61.

An alternative way to create a macro is to add commands using the Create Keyboard
Macro dialog box. To do this:

1 Open the Keyboard Macros dialog box by pressing Ctrl + Shift + M or by selecting

Tools I Keyboard Macros I Macros...

2 Click on Create... to open the Create Keyboard Macro dialog box..
3 Enter the name of the macro in the Keyboard macro name: field.
4 Enter a description of the macro in the Keyboard macro description: field.
5 The Keyboard macro contents: list box lists the commands in the order in

which they will be executed.
To add a command, select the command from the Commands: list box and click

on the double right-directional button. Repeat this step until all commands are
listed in the Keyboard macro contents: list box.

You can reorder commands by selecting the command in the Keyboard macro
contents: list box and clicking on up or down directional button.

To delete a command, select the command and click on Delete .
6 When all of the commands are present in the list box and are ordered correctly,

click on OK .
7 In the Keyboard Macros dialog box, click on Close .

To play a macro, use a keyboard shortcut or :
1 Select

Tools I Keyboard Macros I Run Macro...

2 In the Run Macro dialog box, select a macro and click on Run .

To edit a macro:
1 Open the Keyboard Macro dialog box by pressing Ctrl + Shift + M or by selecting

Tools I Keyboard Macros I Macros...

2 Select a macro and click on Edit... to open the Edit Keyboard Macro dialog box.
3 To add a command, select a command from the Commands: list box and click on

the double right-directional button.
To modify a command, first be sure you can modify the command by selecting

the command from the Keyboard macro contents list box. If a command can be
modified, the Modify button is active. Click on Modify to open a dialog box which
will enable you to modify the command.

To delete a command, select the command in the Keyboard macro contents
list box and click on Delete .

To reorder a command, select the command and click on the up or down
directional button.

4 When the commands are in the correct order, click on OK .

To delete a macro,
1 Press Ctrl + Shift + M or select

Tools I Keyboard Macros I Macros...
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2 Select the macro and click on Delete .

3 Click on Yes in the Delete Macro dialog box.

4 Click on Close .

This example lists the steps to create an RSUBMIT statement, an ENDRSUBMIT
statement, a blank line between these statements, and tabs in by the amount specified
Tabs size: field in the Enhanced Editor Options dialog box.

1 Select

View I Enhanced Editor

2 Select

Tools I Keyboard Macros I Record New Macro

and click on OK in the message box.

3 In the Enhanced Editor window:

a Press Enter.
b Enter rsubmit;
c Press Enter.
d Press Enter.
e Enter endrsubmit;
f Press the Up arrow.
g Press the Tab key.
h Select

Tools I Keyboard Macros I Stop Recording

The resulting macro contains the following commands:

Insert carriage return
Insert character [’r’]
Insert character [’s’]
Insert character [’u’]
Insert character [’b’]
Insert character [’m’]
Insert character [’i’]
Insert character [’t’]
Insert character [’;’]
Insert carriage return
Insert carriage return
Insert character [’e’]
Insert character [’n’]
Insert character [’d’]
Insert character [’r’]
Insert character [’s’]
Insert character [’u’]
Insert character [’b’]
Insert character [’m’]
Insert character [’i’]
Insert character [’t’]
Insert character [’;’]
Move cursor up
Insert character [’|’]
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Keyboard macros can be shard by multiple users by importing or exporting them to
or from a folder using the Keyboard Macros dialog box. To open the Keyboard Macros
dialog box, select

Tools I Keyboard Macros I Macros...

To import a keyboard macro, click on Import , select a folder from the Look in:
drop-down list box and a filename from the list box. Then click on OK .

To export a keyboard macro, click on Export , select a folder from the Look in: field,
type a file name in the File name: field, and click on OK .

Using Collapsible Code Sections
Collapsible code sections, when enabled, allows you to expand or collapse one or more

sections of code. Refer to Display 2.4 on page 56 to see the expand and collapse
controls, and the brackets and lines that delineate code sections.

A section begins with a section word, a comment, or spaces above a section word or
comment. A section ends with the next section keyword, a comment, or space above the
next section word or comment. Section words include the DATA statement, the PROC
statement, and the %MACRO statement. The signature line is the line in which the
section word appears.

An expanded section is indicated by the - control in the margin at the signature
line. To collapse a section, click on - .

A collapsed section is indicated by the + control in the margin and the signature line
is the only line of code that is displayed. To expand a section, click on + in the margin.

Display 2.4 The Enhanced Editor When Collapsible Code Segments Are Enabled

Brackets in the margin and a section line across the editor window mark the
beginning and ending of a section. If you don’t want to see the brackets or the section
line, you can turn them off using the Enhanced Editor dialog box.

To disable collapsible code sections, or brackets and lines, select

Tools I Options I Enhanced Editor... I General

and deselect the appropriate settings:

� Uncheck Collapsible code sections to disable collapsible code section.

� Uncheck Show section lines in text to disable section lines in the editor.

� Uncheck Show section brackets in margin to turn off section brackets in the
margin.
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The following rules apply when you are selecting and editing collapsed segments:
� Selecting a line from the margin that includes a collapsed segment will include all

text within the collapsed segment.
� Selecting a line of text by dragging the mouse over the text or by using the

keyboard selects only that line of text.
� Selecting text from above a collapsed section and into a collapsed signature line

copies from the start of the selection to the end of the selection. The selection will
include any hidden lines above the signature line up to the end of the selection.

� Selecting text on a signature line down into another section marks from the
beginning of the selection to the end of the selection and includes hidden text
below the signature line.

� Any key stroke on a signature line will expand the section.
� Pasting into a signature line or section will expand the section.
� Typing something above a section that affects the section, such as comments or

quotes, will expand the section.
� Pressing Enter at the beginning of a signature line will start adding code at the

beginning of the section.
� Pressing Enter at the end of a signature line will start adding code at the end of

the section.
� Undo will not undo the collapse and expand commands.
� When you search for text and the text is found within a collapsed segment, the

segment is expanded.
� When text within a collapsed segment is to be replaced, the segment is expanded.
� When text within a collapsed segment is to be replaced and you select Replace All ,

collapsed sections do not expand.

Setting Enhanced Editor Options
You can customize how the Enhanced Editor works for you by using the Editor

Options dialog box, as shown in Display 2.5 on page 57.

Display 2.5 Editor Options Dialog Box
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.
To open the Editor Options window from the menu, be sure an Enhanced Editor

window is the active window and select

Tools I Options I Enhanced Editor...

Click on the tabs that are located along the top of the dialog box to navigate to the
settings that you want to change, and then select the options you want. When you are
finished, click on OK .

The following sections describe the pages (or tabs) of the Editor Options dialog box
and how to set the formatting options.

General Editor Options
The General page lets you specify the general options that control how the Enhanced

Editor works. The following are the General options:

Allow cursor movement past end of line
specifies where the insertion point is positioned when you click the mouse pointer
after the last text character on a line. If selected, the insertion point is positioned
where you click the mouse pointer. If not selected, the insertion point is positioned
after the last text character on the line.

Drag and drop text editing
specifies whether selected text can be moved using drag and drop. If checked,
selected text can be moved using drag and drop. If not checked, selected text
cannot be moved using drag and drop.

Show line numbers
specifies whether to display line numbers in the margin. When line numbers are
displayed, the current line number is red.

File type:
specifies the type of file to which tabs, indentation and collapsibe code sections
apply. File types include HTML documents, SAS System program, SCL programs,
and text documents.

Tab size:
specifies the number of spaces to indent.

Insert spaces for tabs
specifies whether to insert the space character or the tab character when you press
the Tab key. If selected, the space character is used. If not selected, the tab
character is used.

Indentation
specifies the type of indentation to use. When None is selected, no indentation is
used. When Automatic is selected, the next line is automatically indented by the
same amount of space the previous line is indented.

Collapsible code sections
specifies whether to enable the expansion and contraction of code sections. If
selected, the collapsible code sections can be collapsed or expanded. If not selected,
all code displays in the editor window. The following settings are active when the
Collapsible code sections setting is selected:

� When Show section lines in text is selected, a line appears after each
section of text.

� When Show section brackets in margin is selected, brackets are
displayed around each section in the margin.
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Clear text on submit
specifies whether to clear the contents of the Enhanced Editor window after you
submit a program for processing. If selected, the Enhanced Editor window is
cleared when you submit the program. If not selected, your program remains in
the editor window. If this setting is selected, you can recall the last submitted
program using the F4 key.

Appearance Options
The Appearance options let you specify foregound and background colors, and font

styles for SAS program elements. You can also create and save color schemes. For more
information on using these appearance options, see “Setting Appearance Options” on
page 59 and “Using Schemes” on page 60. The following are the Appearance options:

File type:
specifies the type of file whose elements you want to color-code. You can color-code
file elements for SAS System programs, SCL programs, HTML documents, and
text documents. The default is the file type of the file you are editing at the time
you invoke the Editor Options dialog box.

Scheme:
is a name that represents a saved set of appearance options for the specified file
type.

Name:
specifies the name of the font for the scheme.

Size:
specifies the font size for the scheme.

Script:
lists the available language scripts for the specified font.

File elements
lists the elements of the specified file type that can be color-coded.

Foreground:
specifies the text color that is to be applied to the selected file element.

Background:
specifies the background color that is to be applied to the selected file element.

Font Style:
specifies whether Normal, Bold, Italic, or Bold Italic font style to be applied
to the file element.

Underlined
specifies whether the file element is to be underlined.

Sample:
displays a sample of the selected file element colors and font.

Setting Appearance Options
When you set appearance options, you set them for the elements of the file type

specified in the File type: drop-down list. As you make your selections, the Sample
box displays your selected formatting. The formatting options that you specify are
applied to all opened Enhanced Editor windows of that file type. When you start the
SAS System, the formatting options that are applied to the Enhanced Editor files are
the formatting options that were in effect when the SAS System last ended.
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To specify appearance options:
1 Open the Editor Options window by selecting

Tools I Options I Enhanced Editor... I Appearance

2 Select a file type from the File type: drop-down list.
3 Optionally, you can select a saved formatting scheme from the Scheme: drop-down

list. For more information on using schemes, see “Using Schemes” on page 60.
4 From the Name: drop-down list , select a font.
5 From the Size: drop-down list, select a font size.
6 From the Script: drop-down list, select a script appropriate for the language

your computer is set up on.
7 For each file element you want to format:

a Select a file element.
b Click in the Foreground: drop-down list and select a color for the file

element. To create a custom color, select Custom and create a color from the
Color dialog box.

c Click on the Background: drop-down list and select a color for the
background of the file element. To create a custom color, select Custom and
create a color from the Color dialog box.

d From the Font Style: drop-down list, select Normal, Bold, Italic, or Bold
Italic.

e If you want the element underlined, select the Underlined box.
8 Review your selections in the Sample box. Click on a file element in the sample to

see its color and font assignment. When you are done formatting all file elements,
click on OK .

Using Schemes
A scheme is a saved set of formatting options. After creating a scheme, you can set

Enhanced Editor appearance options by selecing only a file type and a scheme. Using a
scheme saves you from setting each individual file element.

To create a scheme:
1 Select a file type from the File type: drop-down list.
2 Select a font, font size, and a script.
3 For each file element, select a color for the foreground and background, a font

style, and the underlining option.
4 Click on Save As... and enter a scheme name in the Save Scheme dialog box.
5 Click on OK .

To modify a scheme:
1 Click in the File type: drop-down list. and select a file type.
2 Click in the Scheme: drop-down list and select a scheme.
3 Make the font and file element changes you want.
4 Click on Save As... The selected scheme name will be in the Scheme name entry

box.
5 Click on OK .

To delete a scheme:
1 Click in the File type: drop-down list and select a file type.
2 Click in the Scheme drop-down list and select.
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3 Click on Delete .

Customizing the Enhanced Editor Keyboard
You can customize Enhanced Editor commands and keyboard macros using the

Enhanced Editor Keys dialog box.

Assigning Keyboard Shortcuts
When you open Enhanced Editor Keys dialog box, you can view only commands that

have assigned keyboard shortcuts, or you can view all commands. To see only the
commands with assigned keyboard shortcuts, be sure that the Show all commands
check box is not selected. To see all commands, including those that have no key
assignment, check the Show all commands check box.

To assign keyboard shortcuts:
1 Select

Tools I Options I Enhanced Editor Keys

2 Select a category from the Categories: drop-down list box. Macros are listed in
the User Defined category.

3 Select a command from the Commands list box. If a keyboard shortcut is already
defined for the command, it is displayed in the Keys column.

4 Click on Assign keys... .
5 Place the cursor in the Press new shortcut key: field.
6 Press a key sequence for the selected command. The sequence displays in the

Press new shortcut key: field and the assignment status for that key displays
at the bottom of the dialog box. If New shortcut key is currently assigned
to: is None, then no other command is assigned to this keyboard shortcut.

7 In the When: drop-down list box, select when to use the shortcut key. Select
Always to execute the command whether text is selected or not. Select Text is
selected to execute the command when there is selected text. Select No text is
selected to execute the command when no text is selected.

8 To assign the keyboard shortcut, click on Assign .

Note: Assigning a keyboard shortcut to a key sequence that is assigned to
another command will delete the shortcut for that command. For example, if you
assign the Backspace key to the Add a new abbreviation command, pressing
the Backspace key displays the Add Abbreviation dialog box and you can no longer
backspace using the Backspace key. 4

Deleting Keyboard Shortcuts
To delete a keyboard shortcut:
1 Select

Tools I Options I Enhanced Editor Keys

2 Click on Assign keys... .
3 Select the category in the Categories: list box. Macros are listed in the User

Defined category.
4 Select the command in the Commands: list box.
5 Select the key sequence in the Keys currently assigned to command: list box.
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6 Click on Delete .

Resetting Keyboard Shortcuts to the Enhanced Editor Defaults
Resetting keyboard shortcuts to the default keyboard shortcuts will delete all macro

keyboard shortcuts. See “Keyboard Shortcuts within the Enhanced Editor” on page 518
for a list of the default keyboard shortcuts.

To reset keyboard shortcuts to the Enhanced Editor default keyboard shortcuts:
1 Select

Tools I Options I Enhanced Editor Keys

2 Click on Assign keys... .
3 Click on Reset All .

Enabling and Disabling the Enhanced Editor
By default, the Enhanced Editor is enabled when you start the SAS System. To

disable the Enhanced Editor when you start the SAS System, use the
NOENHANCEDEDITOR system option. For more information about the
NOENHANCEDEDITOR system option, see “ENHANCEDEDITOR” on page 425. You
can also enable or disable the Enhanced Editor using the Use Enhanced Editor
setting in the Preferences dialog box Edit page or by using the WEDIT command. For
more information on the WEDIT command, see “WEDIT” on page 301.

When you disable the Enhanced Editor, Enhanced Editor menu commands are not
available. All opened Enhanced Editor windows remain open and you are able to open
new Enhanced Editor windows using the View menu or the WEDIT command. If the
Enhanced Editor is disabled when you start the SAS System, the Enhanced Editor
window will not open.

When the Enhanced Editor is enabled, the Text Editor command in the Tools
menu will open an Enhanced Editor window. When the Enhanced Editor is disabled,
the Text Editor command opens SAS NOTEPAD.

Customizing Your SAS Session
The SAS windowing environment can be customized in several ways using

commands, dialog boxes, and SAS system options.

Selecting Fonts
To choose a different font or point size for text in SAS windows, open the Fonts

dialog box by selecting

Tools I Options I Fonts

The fonts available depend on what monospace fonts you have installed under
Windows. For example, you might have the Courier font and System font available.
When you select a font or point size, the Font Sample field displays a sample of the
font you have selected.

When you install SAS, the Setup program automatically installs a TrueType font,
named SAS Monospace, designed specifically for use with SAS. This font, in combination
with the Sasfont display font, ensures that tabular output is formatted properly whether
you view it in the Output window, print it, or copy it to another Windows application.
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By default, SAS uses the SAS Monospace font to produce printed output. In addition,
any text that you cut, copy, or drag from a SAS window to paste into another Windows
application will be formatted with the SAS Monospace font.

You cannot use the Fonts item to select SAS/GRAPH fonts.

CAUTION:
Beware of changing certain display characteristics on low-resolution displays. If you
select large font sizes on some monitors, you may not be able to see all the text in
your SAS windows at one time. In some windows, such as the SAS/ASSIST window
where there are no scroll bars, large font sizes can cause some choices to be invisible.
For these types of displays, large font sizes are not recommended. This same
problem can occur if you change the Windows Appearance properties and select a
window border thickness of a thick size. On low-resolution displays, you should not
use thick window borders. 4

Setting Session Preferences
You can configure your SAS session to accommodate the way that you like to work.

For example:
� You can use a movable command box instead of the command bar.
� You can set preferences for scrolling behavior and window appearance.
� You can set a preferred Web browser to use when viewing internet Web pages or

HTML output.

To customize your SAS session, enter DLGPREF in the command bar or select

Tools I Options I Preferences...

The Preferences dialog box (shown in Display 2.6 on page 64) contains different pages
that separate the session settings into different categories. Click on the tabs for each
page that are located along the top of the dialog box to navigate to the settings that you
want to change, and then select the options that you want. When you are finished, click
on OK . The settings that you select are saved from session to session in the
SASUSER.PROFILE catalog by their respecitve pages except for the Results page. The
entries in the SASUSER.PROFILE are GENWSAVE, VIEWWSAVE, EDITWSAVE,
WEBWSAVE, and ADVWSAVE . The Results page settings are saved in the SAS
registry so they are not moved to another machine when the SASUSER.PROFILE
catalog is copied.
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Display 2.6 Preferences Dialog Box (showing the General tab)

The following sections describe each page of the Preferences dialog box and how to
use these settings to control your SAS session.

General Preferences

The General preferences page lets you specify the general options that control how
your SAS session works. The following are the General options:

Recently used file list
specifies whether SAS retains a list of the files that you have accessed. If this
option is selected, you can specify in the Entries field up to 30 files that you want
to retain. Show recently used file list on submenu specifies whether the
files will be displayed from the Recent Files submenu that you access from the
File menu. If Show recently used file list on submenu is not selected, the
files are displayed in the File menu. Each time that you access a file from an
editor window, the filename is added to the list.

Confirm exit
specifies whether you want the SAS System to prompt you for confirmation before
you end your SAS session.

Save settings on exit
specifies whether SAS should automatically save your settings when you exit your
SAS session.

Submit contents of file opened
specifies whether you want to submit the contents of all files that you open to the
SAS System.

Mail current window as attachment
specifies whether the active window should be automatically included as an e-mail
attachment when you initiate electronic mail from within SAS. If you select this
option, then you can also specify whether the attachment should be formatted as
plain text or as RTF (rich text format, which retains font and color information).
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View Preferences
The View preferences page lets you specify the options that control the appearance

of your SAS session. The View options include:

Window
specifies whether your SAS windows contain scroll bars and/or a command line.
You can also enable or disable ScreenTips (the helpful hints that appear when you
position your mouse pointer over window controls).

Show
specifies whether to show certain aspects of the SAS interface, including the
following settings:

Docking View
specifies whether to display the docking area on the left side of the main SAS
window.

Window Bar
specifies whether to display the window bar at the bottom of the main SAS
window.

Status line
specifies which aspects of the status line, if any, you want to have visible in
your session. Display message lines specifies whether to display the
message area of the status line. Display current folder specifies whether
to display the SAS current folder area. Display cursor position specifies
whether to display the line and column position of the Enhanced Editor
cursor.

Edit Preferences
The Edit preferences page controls options that affect the SAS Text Editor, including:

Overtype mode
specifies whether to insert text or overtype on existing text when you type text in
a SAS application window. You can also toggle the overtype mode by pressing the
Insert key on your keyboard.

Autosave every n minutes
specifies whether to automatically save the contents of the PROGRAM EDITOR,
and how often to save it. The contents are saved to pgm.asv in the current active
folder so that you can recover your work in the event that your SAS session ends
without giving you a chance to save the contents of the editor.

Enable unmarking with navigation keys
enables unmarking of text using the up, down, left, and right navigation keys.

Use Enhanced Editor
specifies whether the Enhanced Editor is the primary editor.

Results Page
The Results page lets you configure how you would like to view your program output

results. The Results page options include:

Listing
specifies to display program output in the Output window.
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HTML
specifies to display program output in HTML format.

Style
allows you to choose the appearance of the program output. For more
information, see the topic on customizing the styles used in HTML output in
the SAS System Help.

Folder
specifies a folder to store HTML output files. You can either type a folder
name or click on Browse to search for a folder. This setting is only available
when the Use WORK folder setting is not selected.

Use WORK folder
specifies to store HTML output files in the WORK folder. The WORK folder is
a temporary folder that is deleted when SAS closes.

Autonavigate during results generation
specifies whether to update the browser with the latest generated HTML
output.

View results using
specifies a browser to view HTML program output. Internal browser is
available if Microsoft Internet Explorer is installed. When Internal
browser is selected, SAS displays HTML output using the Results Viewer.

If you select Preferred browser, your HTML output displays using the
browser specified by the Preferred browser - Other text field of the
Preferences dialog box Web page .

Note: If you select Use default on the Preferences dialog box Web page,
your output is displayed using the browser registered with Windows. 4

Web Preferences
The Web preferences page lets you specify your preferred web browser for use within

your SAS session. These preferences are used whenever you issue the WBROWSE
command (either directly or by selecting a Help menu item or toobar button that issues
the command). For more information about the WBROWSE command, see
“WBROWSE” on page 299. You can specify the following Web options:

Preferred browser
specifies the preferred web browser to use when accessing web information from
within the SAS System. By default, the SAS System uses the browser that is
installed on your system and registered with Windows as the default browser. To
use a browser other than the default, select the Other radio button and either type
a path to the web browser or click Browse to search for the path to the Web
browser.

Start page
specifies the default web page to which to navigate when invoking the web
browser within the SAS System. By default, the browser navigates to http://
www.sas.com (the SAS Institute home page on the World Wide Web).

Advanced Preferences
The Advanced preferences page lets you specify a few of the more subtle options that

can affect your SAS session, including scrolling policy and other miscellaneous behavior.
The Advanced options include:
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Scrolling Options
specifies the number of lines that the Log and Output windows scroll when
information is written to them.

For the Output winodw, if Scroll lines is selected and the window is full, the
window will scroll the number of lines specified in the spin box. The default value
is 0 (meaning that no output is written to that window while statements are
executing, providing the best performance). When you select Scroll page, the
Output window will not display any lines until an entire page is written. When
Scroll max is selected, no output will be written to the window until until the
procedure is complete.

The default Scroll lines value for the Log window is 1. The advantage of
keeping the scrolling setting of the Log window at 1 is that the SAS System uses
the Log window to notify you of the status of the running program.

Scrolling can increase the length of time that the SAS System takes to run your
program. The less scrolling that the Log and Output windows have to do, the
faster your program will run.

You can also set these values by using the Editor Options window or the
AUTOSCROLL command. For more information about the AUTOSCROLL
command, see “AUTOSCROLL” on page 271 and SAS System Help.

Other
These are miscellaneous options settings:

Hide cursor in non-input windows
specifies that the cursor will not appear in windows that do not require text
input (such as some SAS/AF programs and SAS/ASSIST software).

Disable scroll bar focus
specifies that the scroll bar does not receive window focus when you click on
it. This eliminates flashing problems that can occur in some SAS System
applications.

Customizing Your Windowing Environment
You can use several commands to customize your SAS windowing environment. This

section describes using some of these commands.

Customizing Windows Positions
In the default display configuration of an interactive session (shown in Display 2.1

on page 27) the main SAS window displays the Explorer and Results windows as
docked windows, and the Log, Program Editor, and Output windows in the remaining
SAS workspace.

Using the Windows menu, you can position SAS windows in the same manner as
other Windows applications: Minimize (Restore) All Windows, Cascade, Tile
Vertically, Tile Horizontally, and Resize. While the default display configuration
is sufficient for efficient SAS System use, you may want to open a few more windows for
easy access and rearrange the windows on your display. For instance, you may want
the My Favorite Folders window open, but minimized, with the windows arranged in a
mosaic pattern so you can see all of them at once. To accomplish this, open the My
Favorite Folders by selecting

View I My Favorite Folders
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After it is opened, click on the minimize button in the window title bar for the My
Favorite Folders window and then select Tile Vertically from the Windows menu.

The resulting main SAS window is displayed in Display 2.7 on page 68:

Display 2.7 Customized SAS Session

In addition, you can undock windows so that all windows can be positioned where
you would like. For more information on the docking view, see “Using the Docking
View” on page 29.

For a list of SAS commands used to control the appearance of the main SAS window,
see “Windowing Environment Commands that Control the Main SAS Window” on page
260 .

Changing the Window Colors
Changing the color of window components is a shared responsibility of Windows and

the SAS System. You change the color of most standard window parts by changing the
Properties of the Windows desktop.

Several window element colors are controlled by the SAS System (such as the color of
error message text in the Log). To change a window component that is controlled by the
SAS System, either type SASCOLOR in the command bar or select

Tools I Options I Colors...

The SASCOLOR window lets you choose the colors to use for specific elements. For more
information about the SASCOLOR window, see the SAS System Help for the window.

Customizing Your Windowing Environment with System Options
Several SAS system options are available to control the default windowing

environment within the SAS System. The most commonly used options are the
following:

AWSDEF
specifies the location and dimensions of the main SAS window when the SAS
System initializes.

AWSTITLE
specifies the text for the main SAS window title bar.
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FONT
specifies a font name and point size to use as the default SAS session font.

ICON
minimizes the SAS window when the SAS System initializes.

REGISTER
enables you to add applications to the main SAS window Tools pull-down menu so
you can execute them by clicking on their names.

SPLASHLOC and NOSPLASH
specifies the location of the logo screen (SPLASHLOC) to display at the start of a
SAS session, or suppresses the logo screen (NOSPLASH).

USERICON
specifies user-defined icons to be incorporated into SAS/AF applications.

WEBUI
specifies to enable mouse-pointing to select an object and a single mouse-click to
invoke the object’s default action.

These system options can be specified in your SAS configuration file or in the SAS
command when you start the SAS System from a DOS window. Some are also valid in
an OPTIONS statement. For details on the syntax of these options and on where you
can specify them, see “SAS System Options under Windows” on page 395.

Changing the Size and Placement of the Main SAS Window
The AWSDEF system option enables you to control the placement and size of the

main SAS window when the SAS System initializes. Suppose you want your SAS
session always to occupy the upper-left quarter of your display. To accomplish this,
specify the following AWSDEF option in your SAS configuration file:

-awsdef 0 0 50 50

For more information about the AWSDEF system option, see “AWSDEF” on page 411.

Changing the Title of Your SAS Session
By default, the main SAS title bar contains the text SAS. If you want a different

title, you can use the AWSTITLE system option. For example, to set the title to My SAS
Session, specify the following option in your SAS configuration file:

-awstitle "My SAS Session"

Minimizing Your SAS Session
The ICON system option causes the SAS System to be minimized at invocation. If

you are running a batch job, you might want to use this system option to save space on
your display.

Adding Applications to the Tools Menu
The REGISTER system option enables you to add names of applications to the

Tools pull-down menu of the main SAS window. You can execute one of these
applications by clicking on its name. The REGISTER system option takes as arguments
a menu name and an operating system command or a path specification for an
executable file. You can also specify a working folder. For more information about the
REGISTER system option, see “REGISTER” on page 451.
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The following is an example that adds a command to print the contents of the SAS
folder:

-register "Contents of SAS"
"dir c:\program files\sas"

When you click on Contents of SAS in the Tools pull-down menu, the output of the
Windows DIR command is displayed in a command prompt window.

The following is an example of adding an .EXE file to the menu along with a
specification of a working folder of C:\EXDATA:

-register "Excel" "excel.exe" "c:\exdata"

This adds Excel to the menu. When you click on Excel, the file EXCEL.EXE is
invoked.

Note: The REGISTER system option is valid only as an invocation option (that is, in
a SAS configuration file or in the SAS invocation command). 4

Displaying a Custom Logo Screen during SAS System Invocation
To display your own logo when the SAS System starts:

1 Create the logo that you want to display and save it either as a Windows bitmap
(which has a BMP file extension), or compile it as a resource and build it into a
DLL.

2 When you invoke SAS, specify the -SPLASHLOC system option with the full
pathname of the file that contains your bitmap. If the bitmap is in a DLL, be sure
to specify the resource number as well. The default resource number is 1.

For example, suppose your logo screen is stored in C:\MYBMPS\SPLASH.BMP.
You would specify the SPLASHLOC system option like this:

-splashloc c:\mybmps\splash.bmp

If your logo was stored in C:\MYDLLS\OPENING.DLL as resource 101, you
would specify the SPLASHLOC system option like this:

-splashloc c:\mydlls\opening.dll 101

For more information about the SPLASHLOC system option, see
“SPLASHLOC” on page 464.

Adding User-Defined Icons to the SAS System
The USERICON system option enables you to add your own icons to the SAS

System. These icons can be used with SAS/AF and SAS/EIS applications. The syntax
for the USERICON system option is as follows:

-USERICON icon-resource-file number-of-icons

The icon-resource-file argument specifies the full path to a dynamic link library
(DLL) file that contains the user icons. The number-of-icons argument specifies the
number of icons found in the resource file. For example, the following system option
specifies that there are four icons located in an icon resource file named ICONS.DLL
found in the C:\JUNK folder:

-usericon c:\junk\icons.dll 4

The DLL that is used as the icon resource file must be created using the Win32
Software Development Kit (and must therefore be 32-bit). For more information about
how to build a resource file, refer to the documentation for the Microsoft Win32
Software Development Kit.
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You can incorporate icons into your SAS/AF and SAS/EIS applications using a
FRAME entry. For more information, refer to the SAS System Help for SAS/AF
software and SAS/EIS software.

Enabling Web Enhancements in the SAS System
If you have Microsoft Internet Explorer 4.0 (IE) or greater installed, the WEBUI

system option enables some SAS System windows, such as the SAS Explorer window, to
work like an IE web page where pointing to an object selects the object and a single
mouse-click invokes the default action. To select a range of objects, press and hold down
the SHIFT key, and point to the first and last objects in the group. To select multiple
items, press and hold down the CTRL key, and point to individual items in the group.

Customizing the Toolbar
The SAS System assigns several commonly used commands to the toolbar buttons

for your convenience. You might find that the commands you use most often are
different than the ones assigned to the toolbar by default. Or, you might want to create
a toolbar to use with a specific application window or SAS/AF program. This section
describes how to customize the toolbar settings.

You customize all toolbar settings using the Customize tools dialog box. To open the
Customize tools dialog box, either enter TOOLEDIT in the command bar or select the

Tools I Customize...

You use the Toolbars page for general toolbar settings and the Customize page to
define tools on the toolbar.

Setting General Toolbar Preferences
The Toolbars page has settings to control the behavior and appearance the toolbar.

Tools options include:

General
specifies toolbar button appearance and help options. These options include:

Large icons
specifies whether to use the set of large buttons on the toolbar. This is
especially useful for high-resolution displays.

Show ScreenTips on toolbars
specifies whether to display a short button description when you place the
cursor over the toolbar button.

Toolbars
specifies whether or not to display the toolbar and command bar. These options
include:

Application Toolbar
specifies whether to display the toolbar for the active application.

Command Bar
specifies to display the command bar and enable the options to use the
command bar.

When Use AutoComplete is selected, SAS remembers previously entered
commands and completes the command once you start typing the
command.

Select Sort commands by most recently used to display commands in
the command bar drop down list by the most recently entered command.
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If this setting is not selected, the drop-down list commands are ordered
by the most frequently used.

In the Number of commands saved box, enter the number of commands
to save to display in the command bar list box. Valid values range
between zero and 50. The default is 15.

When you have configured the Toolbars page, either click on Customize to complete
your customization or click on OK to close the dialog box.

Customizing a Toolbar

The Customize page allows you to add, delete, and modify commands on the toolbar.
Display 2.8 on page 72 shows the Customize page of the Customize Tools dialog box.

Display 2.8 Customize Page of the Customize Tools Dialog Box

You may recognize some buttons as standard Windows buttons, such as the OPEN
and SAVE commands. The following list explains each of the buttons (commands) and
fields:

Commands that act on the file containing the toolbar definition are a series of three
buttons at the top of the page. From left to right:

the open button opens a toolbar file

the save button saves a toolbar file

the restore button restores a toolbar to the default settings

Title
displays the title text which appears in the title bar when the toolbar is undocked.
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Commands to define a toolbar, a series of eight buttons from left to right:

Add a tool
adds a tool or a separator space to the toolbar. This tool has two parts. When
you click on the left button a blank tool is added to the toolbar. When you
click on the the right down arrow, you can select to add either a Blank tool
or Separator. Windows that define an action set (for example, Explorer) will
have a selection for Action.

Remove tool
deletes a highlighted tool in the list box from the toolbar.

Change button
opens the Bitmap Browser to select a new icon for a tool button.

Move tool up
moves a tool up one position in the list box.

Move tool down
moves a tool down one position in the list box.

Cut
deletes the currently selected button from the list box and places it in the
clipboard.

Copy
places a copy of the selected button to the clipboard.

Paste
copies a button from the clipboard to the highlighted command in the list box.

Command
displays the command for the highlighted tool in the list box. You can then add or
modify the command in the text box.

Help Text
displays the help text that appears in the message area of the status bar when the
cursor is placed over the button in the toolbar. You can add or modify the help text
in the text box.

Tip Text
displays the tip text that appears under the button when the cursor is placed over
the button in the toolbar. You can add or modify the tip text in the text box.

Toolbar list box
lists the buttons, commands, help text and separators that are defined in the
toolbar.

To close the dialog box, click on OK .

To Add a Tool to the Toolbar
To add a tool to the toolbar, perform the following steps:

1 Do one of the following:
� Click on the Add tool button to add a blank tool to the list box. Enter a SAS

command in the Command text field.
� For windows that have a set of predefined tools, such as the SAS Explorer

window or the My Favorite Folders window, click on the Add tool down
arrow and select Action. From the Add Action dialog box, select an action.
This add a new action to the toolbar. You can enter multiple commands
separated by semicolons.
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� Click on the Add tool down arrow and select Separator to add a separator
to the toolbar.

2 Click on the Bitmap Browser button. Select a button in the Bitmap Browser
dialog box, shown in Display 2.9 on page 74, and click on OK .

3 Enter text in the Help Text field that will appear in the message area of the
status line when you select the tool from the toolbar.

4 Enter text in the Tip Text field that will appear under the button when you place
the cursor over the button.

5 Position the tool in the listbox by clicking on Move Up and Move Down buttons.
6 When you are finished, click on the Save button. In the Save Tools dialog box,

enter the library, catalog, and toolbox name. Then click on OK .

Display 2.9 Bitmap Browser Dialog Box

Removing a Tool from the Toolbar
To remove a tool from the toolbar, select the tool in the list box that you want to

remove and click on the Remove Tool button. When you are finished, save the toolbar
by clicking on the Save button.

Customizing and Saving a Toolbar for Use with a Particular Application or
Window

Use the following procedure to customize a toolbar for use with a particular
application or window:

1 Click in the application or window to make it the active window.
2 Customize the toolbar by adding and removing tools as described in previous

sections.
3 When you are finished customizing the toolbar, click on the Save button. The Save

Tools dialog box appears (as shown in Display 2.10 on page 75).
4 The SAS System completes the libref, catalog, and entry fields. Select the Save

tools for window check box, where window is the active window, and then click
on OK .

When you select the Save tools for window check box, the toolbar is
associated with the particular application or window by using the same library,
catalog, and entry name as the PMENU entry for the application or window. The
SAS System first looks for toolbox entries in SASUSER.PROFILE before searching
the application catalog.
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Display 2.10 Save Tools Dialog Box

If you save the toolbar so that it is associated with a particular application, SAS
automatically loads the tools when that application’s window is active.

You can use the TOOLLOAD command to load your custom toolbar manually. For
more information about the TOOLLOAD command, see “TOOLLOAD” on page 295.

Resetting the Tools to the Default Settings
Click on the Restore Defaults button. The SAS System asks you to confirm that you

want to restore to the default tool settings. When you click on Yes , the tools are reset
to their original settings (the settings that were in place when the SAS System was
installed).

If a SAS System application defines a default toolbar for its application window,
clicking on the Restore Defaults button restores the settings for that toolbar.

Examples of Useful Tools You Can Create
Suppose you want to create a tool that opens the SAS online documentation on the

CD-ROM (SAS OnlineDoc). You would perform the following steps:

1 In the Customize page of the Customize Tools dialog box, click on the Add tool
button. This creates a template for a new tool in the list box.

2 In the Command field, type sas onlinedoc which is the command for invoking the
SAS OnlineDoc product. For more information about Windows-specific SAS
commands and their options, see “SAS Commands under Windows” on page 270.
For information about portable SAS commands, refer to SAS System Help.

In the Help Text field, type Open the SAS OnlineDoc. In the Tip Text
field, type SAS OnlineDoc.

3 Click on the Bitmap Browser button. From the Bitmap Browser dialog box, select
a bitmap appropriate for the help action (such as a PC with text bitmap) and click
on OK .

4 Use Move Up and Move Down buttons to move the tool to the location you want on
the toolbar.

5 Click on the Save button to save the tool with your default tool configuration.

The following are some examples of other tools that you might find useful to create:

PGM; CLEAR; INCLUDE C:\SAS\MYPROGRAM.SAS
includes a program that you use often into the Program Editor window for editing.
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PGM; FILE C:\SAS\MYPROGRAM.SAS; CLEAR
saves a SAS program after you finish editing it and clears the Program Editor
window.

PGM; CLEAR; INCLUDE C:\SAS\MYPROGRAM.SAS; SUBMIT
includes and submits a SAS program that you use often.

PGM; CLEAR; INCLUDE C:\SAS\SIGNON.SAS; SUBMIT
includes and submits a SAS program to sign on to a remote system. For example,
to sign on to a remote MVS session, the SIGNON.SAS program might contain:

options comamid=ehllapi remote=mytso;
libname remtdata ’mylib.mydata.monthly’;
signon;

For more information about signing on to remote sessions, see SAS/CONNECT
User’s Guide.

PGM; CLEAR; INCLUDE C:\SAS\DOWNLOAD.SAS; SUBMIT
includes and submits a SAS program to download a data set from a remote
session. Assuming that you have already signed on to the remote session,
DOWNLOAD.SAS might contain:

proc download data=remtdata.june;
/* where libname ’remtdata’ is */
/* already defined */

run;

For more information about signing on to remote sessions, see SAS/CONNECT
User’s Guide.

TOOLLOAD BAR SASUSER.PROFILE.MORTOOLS
loads a different toolbar (that you created) containing another collection of tools.
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